YAMAHA Wave Editor TWE
Version 2.31 for Windows

Owner’s manual

The TWE wave editor (hereafter referred to as TWE) is software for digitally recording sounds
(instrumental sounds, sound effects, voice, etc.) to the hard disk of a personal computer, and for editing
recorded sound data. If an external Yamaha sampler (*) is connected via a SCSI connection, the sound data
recorded in the sampler can be loaded into TWE and edited, and then re-transmitted back to the
sampler.*This software supports the Yamaha A3000 professional sampler and the EX7, EX5, and EX5R
synthesizers. It also supports the Yamaha CBX-D5/D3 digital recording processors. Under Win9.x/ME
only with suitable ASPI control.

TWE was created by Yamaha Corporation, and is distributed at no cost. Yamaha Corporation makes no
guarantees, implicit or explicit, regarding the quality or performance of this software. Yamaha Corporation
will accept no responsibility for any damages, direct or consequential (including extended damages), which
may result from use of this software. You must make backups of data files you create.

In order to use this software, you will need to be familiar with the connected device (CBX-D5/D3,

A3000, EX7, EXS, EX5R), with PC-compatible computers, and with Windows95/98/ME (If used with
Yamaha hardware for ASPI control) . Before using this software, please carefully read this manual and the
manuals for your connected device, PC compatible computer, and Windows

*By using this software, it is possible to create sound data which could not be produced by normal
recording. However, be aware that playing back high volume full-scale data, or data of extremely low
frequencies below 20 Hertz, or data with a large direct current component may damage your ears
and/or any speakers or headphones that are connected.

Please use caution.

e  The software and this owner’s manual are the exclusive copyrights of Yamaha Corporation.

e Copying of the software or reproduction of this manual in whole or in part by any means is expressly
forbidden without the written consent of the manufacturer.

e Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.

o Since this software is being distributed in free of charge, no user support will be provided.

e Copying of the commercially available music sequence data and/or digital audio files is strictly
prohibited except for your personal use.

e  The company names and product names in this owner’s manual are the trademarks or registered
trademarks of their respective companies.

e  The screen displays as illustrated in this owner’s manual are for instructional purposes, and may appear
somewhat different from the screens which appear on your computer.
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1. Operating environment

Computer PC compatible
CPU Pentium/75MHz or better (L00MHz or better is recommended)
oS Windows95
Memory 16MB or more
Hard disk Average access time 30ms or less
SCSI board Compatible with Windows95 ASPI Manager (only when using the CBX-
D5/D3, A3000, EX7, EX5, or EX5R)
Record/playback system
CBX-D5/D3
Playback Sample size : 8bit/16bit
Sample rate : 11.025k-48k
Mono/Stereo
Recording Sample size : 16bit
Sample rate : 22.05k/32k/44.1k/48k
Mono/Stereo

*In order to use the CBX-D5/D3 with Windows95, the internal ROM of the CBX-D5/D3 must be updated to
support Windows95. A CBX-D5/D3 with an earlier internal ROM will not be recognized by Windows95,
and thus will be unable to use TWE. (In this case, nothing will be shown in the "4.2. Device information
display" described below.) The following ROM versions support Windows95.

CBX-D5 209A or later
CBX-D3 002B or later (without firmware)

For updating your CBX-D5/D3 to a ROM version which supports Windows95, contact your nearest
YAMAHA or the authorized distributor.

*Even if you do not have a CBX-D5/D3, you can still use TWE with just the sound card of your computer.

Windows Sound System Performance such as sampling frequency etc. will depend on the sound card
that is installed

Device for receiving/transmitting sound data
A3000, EX7, EX5, EX5R Via SCSI (SCSI Intade Board option ASIB1 is required)

*TWE can also be used without the A3000, EX7, EX5, or EX5R .

*When Windows95 is started up for the first time with the CBX-D5/D3, A3000, EX7, EX5, or EX5R connected
via SCSI, Windows 95 will detect these devices as "unknown devices." TWE does not require drivers for the
CBX-D5/D3, A3000, EX7, EX5, and EX5R, so when the driver select dialog box appears, select "Do not install
drivers."



2. Installing and starting TWE

TWE can be used without any particular installation procedure, simply by placing the following
three files in the same folder, and double-clicking the Twe.exe file icon.

Twe.exe
aspiCtr.dll
CBXFirm.dll

When TWE is started up, the application window will open, and various menus and toolbar will
appear. Next, a "Select Working Dir..." dialog box will appear. Here you can specify the directory
in which TWE will create its temporary working files. (The working directory that you specify
here can be changed using the [Option] menu command [Select Working Dir...]. Refer to "9.4.
Select Working Dir...".)

After specifying the working directory, use the [File] menu command [Open] etc. to open a sound
data file (sound file), and the Wave Window (TWE's main window which displays various

settings of the sound file) will appear. The following chapters explain the various parts of TWE's
windows.

3. Toolbar

3.1. Console
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The Console is a toolbar where sound data can be played back and recorded, etc.

M Rewind: Moves the playback start location (Play Location) to the beginning of the sound
data. If a region has been selected in the waveform display area, and the selected region
has not been locked, clicking this button will defeat the region selection.

ﬂ Stop: Stops playback/recording.

ﬂ Play: Begins playback from the playback start location. If a region has been selected in
the waveform display, and that region has not been locked, clicking this button will
defeat the region selection. Even if the playback start location has been specified for only
one channel of stereo sound data, both channels will be played back.

ﬂ Record: Begins recording from the playback start location. If a region has been selected
in the waveform display, and that region has not been locked, clicking this button will
defeat the region selection. Even if only one channel of stereo sound data has been
selected, both channels will be recorded.

* Sound data can be converted between stereo/mono using the [File] menu commands [Add Channel] or
[Delete Channel].

I Region Play:If a region is selected in the waveform display area, only that region will
play back.
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3.2. Standard

*The TWE window contains two waveform displays. In this manual, the upper display (blue waveform)
is referred to as the "waveform display.” The lower display (red waveform) is referred to as the "overall
waveform display.” The waveform display can be made to show a magnified portion of the overall
waveform display. For details on the waveform display, refer to "4.7. Waveform display," and on the
overall waveform display refer to "4.8. Overall waveform display."”

Loop Mode: Turn looping on/off. When this is on, and if a loop region has been

specified following the playback start location, clicking the Play bLLLwiII play
back the loop portion of the waveform. The on/off status is saved in the sound file, and
will be transmitted together with the sound data to the A3000 or EX.

Saving the loop start and end points

When you are editing WAVE format (.WAV) sound data, the loop start and end points can be saved in
the sound file only when the Loop Mode is turned on.

When you are editing AIFF format sound data, the specified loop start and end points will be saved in
the sound file regardless of whether the Loop Mode is on/off. However if the original AIFF file has
never before been saved with the Loop Mode on, the loop start and end points may not be saved.

Recording Monitor: Turn the recording monitor on/off. When this is on, the input to the CBX-
D5/D3 will always be output from the CBX-D5/D3. When this is off, it will be output only during
recording.
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Standard is a tool bar which collects commands that are frequently used during editing, such as
opening or saving a file.
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New: Creates a new file (empty sound file). This is the same command as the [File] menu
command [New].

Open: Opens an existing sound file (WAV or AIFF file). This is the same command as
the [File] menu command [Open].

*Sound files from a floppy disk or removable disk must first be copied to the hard disk before they are
opened.

Save:Saves sound data that was edited using TWE by overwriting it onto the original
sound file. This is the same command as the [File] menu command [Save].

* |t is not possible to save to a floppy disk or a removable disk.

Cut: If aregion is selected in the waveform display, that region will be cut and copied to
TWE's clipboard. This is the same command as the [Edit] menu command [Cut].



3.3. View

Copy: If aregion is selected in the waveform display, that region will be copied to TWE's
clipboard. This is the same command as the [Edit] menu command [Copy].

Paste: The waveform which had been copied to TWE's clipboard will be pasted starting
at the specified location (the green line displayed when you click) of the waveform
display. This is the same command as the [Edit] menu command [Paste].

About: This displays information about the software version of TWE.

:|‘-|3||

The View toolbar lets you specify how the waveform will be displayed.

Overview: Specify whether or not the overall waveform will be displayed.

Waveform: Specify whether or not the waveform will be displayed in the waveform
display area.

*This does not erase the waveform data.

Level Ruler: Specify whether or not the amplitude (vertical) axis will be displayed at the
left of the waveform display.

4. Wave Window

The Wave Window is TWE's main window, in which various settings of the sound file are shown.
A Wave Window will open when you execute one of the [File] menu commands [Open], [New],
or [Import Sampler]. Up to twenty of these windows can be open at once.

4.1. File information display (File Info)

This display section is located at the left of the waveform display, and displays various
information.

The following information is displayed for the sound file currently opened by TWE. If the device
information display (Device) is open, click the File Info tab.

File type: Displays the file type (WAV or AIFF).
Rate: Displays the sampling frequency of the sound file in Hertz (Hz).

Size: Displays the sample size of the sound file in bits.
Channels: Displays the number of channels within the sound file. Stereo will be

displayed as 2 channels, and monaural as 1 channel.

Samples: Displays the total number of samples in the sound file.



Length: Displays the total playback time of the file
(hours:minutes:seconds.milliseconds).

Data size: Displays the size (number of bytes) of the sound file.

Modified: Displays the last time the file was modified (year.month.day).

Max chl: Displays the maximum data value of the channel 1 in decibels (dB).

Min chl: Displays the minimum data value of the channel 1 in decibels (dB).

Ave chl: Displays the average data value of the channel 1 in decibels (dB).

*The items listed above are for the case of a monaural sound file (consists of a single channel). In the case of a
stereo file, Max ch2/Min ch2/Ave ch2 will be added.

The "Editing:" field located above the file information display shows whether the currently edited
sound file is an original or a copy. For details on original/copy, refer to "9.5. File Backup.”
4.2. Device information display (Device)
This display section is located at the left of the waveform display.
The following information on the audio input/output device is displayed. If the file information is

displayed (File Info), click the Device tab.

In:;, Out: If a CBX-D5/D3 is connected, you can specify the CBX-D5/D3's recording channel
and playback channel.

Vol: Specifies the volume for playback. In the case of stereo sound data, it is not possible to
set the volume of the channels independently.

Working Volume: Indicates the disk where the currently selected working directory is
located.

*The working directory can be changed using the [Option] menu command [Select Working Dir.].
Input Audio Device: Indicates the currently selected audio input device.

Output Audio Device: Indicates the currently selected audio output device.
*The audio input/output devices can be selected using the [Option] menu commands [Windows
Sound Device Configuration].

4.3. Playback start location display (Play Location)

Play location
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This numerically indicates the location at which playback will begin. The upper line shows the
time location (hours/minutes/seconds/milliseconds), and the lower line shows the number of
samples up to that point.

You can click on one of these values and type in the numerical value from the keyboard of your
computer. Numerical values can be input either for the upper (time) or lower (sample) fields.
Changing one will cause the other to be calculated and set automatically.



If you click the mouse on the waveform display area, the location at which you clicked (or if you
dragged the mouse, the starting location) will be specified as the playback start location.
While sound data is being played back or recorded, the current location is displayed in realtime.

4.4. Selected region display (Sel)
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This numerically indicates the region that has been selected in the waveform display. (The
selected region is displayed on a black background with a highlighted waveform.) The start, end,
and length of the region are displayed as a number of samples (Samples) and as
hours/minutes/seconds/milliseconds (Time).

You can click on one of these values and type in the numerical value from the keyboard of your
computer. Numerical values can be input either for Samples or Time fields. Changing one will
cause the other to be calculated and set automatically.

You can also specify the selected region by dragging to left or right in the waveform display area.
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If the region lock buttol " is pressed, these values cannot be changed. In this case, you can
change the playback start location (Play Location) without affecting the selected region.

4.5. Loop region display (Loop)

Loop Samples Time
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This numerically indicates the loop region. The start, end, and length of the loop region are
displayed as a number of samples (Samples) and as hours/minutes/seconds/milliseconds (Time).
You can click on one of these values and type in the numerical value from the keyboard of your
computer. Numerical values can be input either for Samples or Time fields. Changing one will
cause the other to be calculated and set automatically.

By using the left mouse button to click or drag over the time axis located above the waveform
display, you can modify the loop start point. By using the right mouse button to click or drag, you
can modify the loop end point.
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During playback, you can use the loop start setting and loop end setting [=ktorset the loop
start or end point at the current playback location.



If the loop region lock butto™ has been pressed, it will not be possible to modify the various
loop region values.

If the loop length lock butto @ has been pressed, changing either the loop start point or loop end
point will automatically modify the other point so as to preserve the length of the loop region.

4.6. Display resolution (Zoom)

Zoom
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This numerically indicates the resolution of the time axis (horizontal) and amplitude axis (vertical)
at which the waveform is displayed in the waveform display area.

When you click one of the zoom values, a popup menu will appear, allowing you to select a value.
Alternatively, you can click the magnifying glass buttons to modify the values.

*When the resolution of the time axis (horizontal) is 11 or higher, the waveform in the waveform display will be
shown in dark blue, and the waveform display will not scroll even if Scroll During Playback mode is selected.
Also, when the resolution of the time axis is 10 or lower, the waveform in the waveform display will be shown in
light blue, and if Scroll During Playback is selected, the waveform display will scroll during playback.

* For details on Scroll During Playback mode, refer to "8.10. Scroll During Playback."
4.7. Waveform display (Waveform)

This area shows a magnified portion of the currently opened sound file.

You can use the horizontal and vertical scroll bars to move the displayed portion.

If you click on any desired location of the waveform display, a green line will appear, and that
location will be specified as the playback start location (Play Location).

If you drag to left or right on the waveform display, the background will turn black and the
waveform will be highlighted, and this region will be selected.

*The precision of the region that can be selected by dragging over the waveform display is limited by the
resolution that is selected in the display resolution (Zoom). If you want to select a region even more precisely, you
can type directly into the numerical fields of the selected region display (Sel).

* |f the selected region is not locked, clicking on the waveform display area will defeat the previously selected
region.

* To simultaneously select both channels of stereo sound data, drag across the line between the two channels.
Some operations which modify the length of the waveform, such as the [Edit] menu command [Cut], cannot be
executed unless both channels are selected simultaneously.

By using the left mouse button to drag over the the time axis located above the waveform display,
you can set the loop start point. By using the right mouse button to drag, you can set the loop end
point. The loop start and end points are shown by a brown line.



4.8. Overall waveform display (Overview)
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The overall waveform display shows a graphic image of the entire sound file that is currently
opened by TWE. The gray bar shown below indicates the portion of the entire waveform that is
currently displayed in the waveform display.

The brown vertical lines in the waveform graphic indicate the start/end points of the loop region.
The black vertical lines below the waveform graphic (in the gray area) indicate the start/end points
of the selected region.

By clicking or dragging in the overall waveform display, you can specify the portion of the
waveform which will be displayed in the waveform display.

4.9. Status bar

The status bar located at the bottom of the Wave Window shows the following information, from

left to right.
Complete Scan | M O0:00:00.714031488)
S D0:00:00.25501 1264) |E 00:00:01.154(52224) |D O0:00:00.925 409600

Overall waveform display ratio: While a sound file is being loaded, this indicates the
percentage of the waveform that is shown in the overall waveform display area. When the
sound file has been completely loaded, this will indicate "Complete Scan."

Mouse location indicator (N): Indicates the location of the mouse pointer in the waveform
display, as "hours:minutes:seconds.milliseconds (number of samples)."

Selected region indicator: Indicates the start (S), end (E), and length (D) of the selected
region in the waveform display as "hours:minutes:seconds.milliseconds (number of
samples).”

5. About the play modes
When recording/playing back using the CBX-D5/D3, two play modes are available: HD Play/Rec
mode and RAM Play/Rec mode. You can maximize the performance of your system by using the
mode appropriate for your situation. These two modes are explained below.

5.1. HD Play/Rec mode

Record/playback data will be accessed by the CBX-D5/D3 directly from the HD without passing through
the personal computer. This means that when this mode is used, the load on the computer will be less, and
screen redrawing etc. will be faster.



However in the following cases, this mode may not be able to perform recording/playback correctly.

- While certain types of hard disk utility software is running.

- If AIFF files created by certain application software are used.

- If the computer has two or more SCSI buses, and the bus connected to the CBX-D5/D3 is different than
the bus which is connected to the hard disk that contains the file being recorded or played.

- If the computer has an IDE bus, and the file being recorded/played back exists on a hard disk on that bus.
- If the format of the hard disk is FAT32.
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5.2. RAM Play/Rec mode

Playback will be output from the CBX-D5/D3 after the data from the hard disk has been
accumulated in the RAM of the computer. When recording, the input from the CBX-D5/D3 will
be accumulated in the RAM of the computer, and then stored to the hard disk.

When this mode is used, the data passes through computer RAM, avoiding the limitations that
were mentioned in the explanation for HD Play/Rec mode.

However in this mode, a greater volume of data will be flowing through the SCSI bus. This means
that this method is not suitable if you are using a slow hard disk to process large amounts of data.
Also, since the audio file will always pass through the personal computer, processing such as
display may be slowed down.
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6. FILE menu

6.1. New...

This command creates a new file (empty sound file).
When you select the [New] command, a dialog box will appear, allowing you to set the following

parameters.

File type: Select whether the new file will be a WAVE (\WAV) file or an AIFF file.
Channels: Select whether the new file will be monaural or stereo.

Size: Select the sample size (bit) of the new file.

Rate: Select the sampling frequency (Hz) of the new file.

Fill Zero: The [New] command will newly allocate disk space and will create a temporary

sound file. Normally, empty disk space contains meaningless random data, so that simply
allocating disk space will create a file which contains meaningless data. The "Fill Zero" function
will write zeros into the newly created file to create a file of silence.

If Fill Zero ON is checked (default), the newly created file will contain silence. However, some
time will be required to create the file.

If Fill Zero OFF is checked, the newly created sound file will still contain meaningless data.
However, no time will be required to create the file. (This is convenient when you will be
overwriting the data, such as when you will be recording immediately.)

Length: Specify the length (playback time) of the new file in minutes (min):seconds (sec).

6.2. Open...

This command opens an existing sound file. TWE can open AIFF or normal (PCM type) WAVE
format (\WAV) files.

* A maximum of twenty sound files (Wave Windows) can be open simultaneously.

* Sound files on a floppy disk or removable disk must first be copied to the hard disk before they are opened.

TWE can operate in one of two modes: Original mode in which the original sound file will be
edited directly, or Backup mode in which the original sound file will be copied for editing. The
"Editing:" indicator located at the top of the file information area (File Info) will show whether
you are editing the original or a copy.

To switch modes, click the [Option] menu item [File Backup] before you execute the [Open]
command. If [File Backup] is checked, backup mode (copy editing mode) will be used. If it is
unchecked, original mode will be used. The default setting is Original mode.

6.3. Close

This command closes the sound file (Wave Window).
In backup mode, if the edited content has not been saved, you will be asked whether or not you
wish to save. Select one of the following choices.



[Yes]: Save the edited content and close the sound file.
[No]: Close the sound file without saving the edited content. Your edits will be lost.
[Cancel]:  The sound file will not be closed, nor will the edited content be saved.

* In Original mode, editing operations in TWE will automatically be reflected in the original sound file, so an
additional save confirmation message will not be displayed.

6.4. Save

In Backup mode, this command overwrites the edited sound data onto the original sound file.

* In Original mode, editing operations in TWE will automatically be reflected in the original sound file, so it is not
necessary to select the [Save] command.

6.5. Save As...

This command saves the edited sound data as a new file with a different name than the original
file. In this dialog box you can also specify a different format for saving.

* |t is not possible to save to a floppy disk or a removable disk.

6.6. Revert
In Backup mode, this command returns the edited content to the state which was last saved.
* In Original mode, TWE editing operations are reflected directly in the original sound file, so the [Revert]
command cannot be selected.

6.7. Resample...

This command converts the sampling frequency of the sound data.
A FIR filter is used for the conversion. The characteristics of this FIR filter can be set by three
parameters: FIR Order, Rejection, and Sampling Rate.

FIR Order: Specify the coefficient of the FIR filter which will be used for the
conversion. The higher this value, the better the quality will be, but a
longer time will be required for processing.

Rejection(dB): Specify the ratio at which aliasing noise will be canceled. As this value is
raised, the noise produced during conversion will decrease, but the high
frequency range will be cut.

Sampling RateSpecify the sampling frequency after conversion. The available range is
11,025-48,000Hz.

6.8. Size...

This command converts the sample size (number of bits) of the sound data.



6.9. Add Channel

This command adds a silent channel to monaural data to convert it to stereo data.

6.10. Delete Channel...

This command deletes the specified channel from stereo sound data, converting it to monaural
data.

6.11. Swap Channels

This command exchanges channels 1 and 2 of stereo sound data.

6.12. Format Conversion...

This command converts the file format of the sound data between AIFF <-> WAVE (\WAYV).

6.13. Eliminate DC Offset

This command eliminates any DC (direct current) portion of the sound data. However, this
command cannot be used unless the overall waveform display has been completed.
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6.14. Import Sampler...

When an external Yamaha sampler (A3000, EX7, EX5, EX5R) is connected via SCSI, this
command loads sound data from the sampler into TWE. The desired sound data must first be
loaded into the wave memory of the A3000 or the DRAM of the EX.

* |f you are using an A3000, you must first select MIDI-Bulk in Utility mode, and turn off the Bulk Dump Protect
setting.

* If you are using an EX7, EX5, or EX5R, only those samples which are stored in DRAM can be transmitted to
TWE. Samples stored in FLASH cannot be transmitted. If you wish to transmit samples stored in FLASH to TWE,
you must execute the Copy Sample function on the EX to copy the desired sample from FLASH to DRAM, and
then execute TWE's [Import Sampler...] command.

6.15. Export Sampler...

When an external Yamaha sampler (A3000, EX7, EX5, EX5R) is connected via SCSI, this
command transmits a sound file to the sampler. The transmitted sound file will be placed in the
wave memory of the A3000 or the DRAM of the EX as a new sample.



* The sound file can be transmitted to the EX as any specified sample number from 1 to 1024, and if a sample
already exists at that number in the EX, it will be overwritten by the newly transmitted sample.

* |f you are using an A3000, you must first select MIDI-Bulk in Utility mode, and turn off the Bulk Dump
Protect setting.

* Many of the sound parameters associated with A3000 samples will be lost when the sample is imported into
TWE. This means that after a sound data file which was imported from the A3000 to TWE is once again
exported back to the A3000, the sound parameters and various other settings may have changed.

* TWE will always export the data to the A3000 as 16 bit waveform data, regardless of the sample size of the
TWE sound file.

*When the name conflict occurs in the A3000, the A3000 will add a serial number at the end of the sample
name.

6.16. Quit

This command closes all currently open sound files (Wave Windows), and exits TWE.

7. Edit menu

7.1. Undo (or Redo)
The [Undo] command restores the data to the state in which it was before the previous editing
operation. After Undo has been executed, the [Undo] item in the [Edit] menu will change to
[Redo]. The [Redo] will bring back the edited data which had been canceled by Undo.

7.2. Cut
This command cuts the region that is currently selected in the waveform display, and copies it to
the TWE clipboard. The data following the region which was cut will slide forward.
In the case of stereo sound data, this [Cut] command can be executed only if the selected region
includes both channels.

7.3. Copy
This command copies the region currently selected in the waveform display to the TWE
clipboard.

7.4. Paste

This command pastes the waveform which was copied to the TWE clipboard, starting at the
specified point in the waveform display (the green line that is displayed when you click).



If a region is selected in the waveform display, the data will be pasted starting at the beginning of
the selected region.

If waveform data already exists at the paste destination, the original data will be overwritten and
replaced by the newly pasted data. If the overwritten area extends beyond the end of the sound
data, the sound data will be extended by that amount. Executing the [Paste] command will not
affect the contents of the clipboard.

7.5. Insert

This command inserts the waveform which was copied to the TWE clipboard at the specified
point in the waveform display (the green line that is displayed when you click). The portion of the
waveform following the green line will slide backward to make room for the inserted data.

If a region is selected in the waveform display, the contents of the selected region will be erased,
and the contents of the TWE clipboard will be inserted in its place. The portion following the
selected region will slide backward to make room for the inserted data.

Executing the [Insert] command will not affect the contents of the clipboard.

In the case of stereo sound data, this [Insert] command can be executed only if the selected region
includes both channels.

7.6. Clear

This command deletes the waveform in the region selected in the waveform display. The portion
following the cleared area will slide forward.

Unlike the [Cut] command, the deleted waveform will not be copied to the TWE clipboard.

In the case of stereo sound data, this [Clear] command can be executed only if the selected region
includes both channels.

7.7. Select All

This command selects the entire length (from the beginning to the end) of the channel(s) in which
a region is currently selected in the waveform display.

7.8. Trim

This command leaves only the waveform in the selected region, and deletes the portions of the
waveform which lie before and after the selected region.

In the case of stereo sound data, this [Trim] command can be executed only if the selected region
includes both channels.

* The deleted portion of the waveform will not be copied to the TWE clipboard.



7.9. Mix

This command pastes the waveform which was copied to the TWE clipboard, starting at the
specified location in the waveform display (the green line that is displayed when you click).

If a region of the waveform is selected, the data will be pasted starting at the beginning of the
selected region.

Unlike the [Paste] command, the original data will be mixed with the pasted data if the destination
already contains waveform data.

Executing the [Mix] command will not affect the contents of the clipboard.

7.10. Reverse

This command flips the selected region of the waveform from left to right.
' I Reverse ‘

This command inverts (up/down) the selected region of the waveform.

H -
—

This command fades-in the selected region of the waveform (i.e., gradually raises the volume
from zero).

7.11. Invert

7.12. Fade In

7.13. Fade Out

This command fades-out the selected region of the waveform (i.e., gradually lowers the volume to
zero).

7.14. Loop cross fade...

If unwanted noise (click noise) occurs during loop playback at the boundary between the loop end

and beginning, this command can be used to rewrite the waveform in the area near the end of the
loop, to smooth the transition.



Normally you will select Sustain type. In this case, the waveform immediately before the end of
the loop region will be crossfaded and rewritten. If you select Sustain + Release type, the
waveform immediately before and after the end of the loop region will be crossfaded and
rewritten.

* If you have imported sound data which had an A3000 Loop Mode setting of "Forward loop, Exit
at Note-off", select the Sustain + Release type.

Higher values for Sustain: and Release: will lengthen the area which will be crossfaded and
rewritten, causing the loop playback to be smoother.

Curve lets you select the type of curve for the fade-in/out used for crossfading.

Linear: The data will be faded in/out linearly.

+EXp: The data will be faded in/out more gently than Linear. The volume of the
crossfaded portion can be increased somewhat.

-Exp: The data will be faded in/out more abruptly than Linear. The volume of

the crossfaded portion can be decreased somewhat.

7.15. EQ...

This command applies equalization to the selected region of the waveform.
This is a parametric equalizer which allows you to specify gain (Gain), frequency (Freq), and Q
for each of three bands: low (Low), middle (Mid), and high (High).

By default, the three bands (High, Mid, Low) are all set as presence filters. But Low and High can
also be used as shelving filters.

* A presence filter is a type of filter which boosts or cuts the signal level at a specified frequency, producing a
hill-shaped or valley-shaped curve when viewed on the graph.

* A shelving filter is a type of filter which boosts or cuts the entire portion of the frequency range which lies above
(or below) a specified frequency, producing a shelf-shaped curve when viewed on the graph.

The parameters (Gain, Freq, Q) provided for each band have the following functions.
Gain: Specify the amount of boost or cut in decibel (dB) units which will be
applied at the frequency specified by Freq.

Freq: In the case of a presence filter, specify the frequency at which the signal
will be boosted or cut. In the case of a shelving filter, specify the boundary
separating the region which will be boosted or cut from the region which
will be unaffected.

Q: In the case of a presence filter, specify the steepness of the hill-shaped or
valley-shaped curve that will be created by boosting or cutting at the
specified frequency. As this value is increased, the curve on the graph will
become steeper. If you input 0 as the Q for Low or High, it will function as
a shelving filter (LSF or HSF).



You can click on one of these values and type in the numerical value from the keyboard of your
computer. Alternatively, you can click one of the Low, Mid or High buttons, and then drag the
curve in the graph to modify the Gain and Freq for each band.

Equalizer settings will be applied when you click [EQ]. To cancel the equalizer settings, click
[Cancel]. Clicking [Reset] will return all values to their defaults.

7.16. Time Comp / Exp...

This command modifies only the length of the selected region of the waveform, without affecting
the pitch.

To change the length, drag the slider to left or right to specify the percentage, or type a number of
samples into the Modified box.

In the case of stereo sound data, this [Time Comp/Exp...] command can be executed only if the
selected region includes both channels.

7.17. Pitch Shift...
This command modifies only the pitch of the selected region of the waveform, without affecting
the length.

To change the pitch, drag the slider to left or right, or type a numeric value into the Rate (%) or
Cent boxes.

7.18. Gain...
This command modifies the overall amplitude (volume) of the selected region of the waveform.

To change the amplitude (volume), drag the slider to left or right, or type a numeric value into the
Rate (%) or dB (decibel) boxes.

7.19. Normalize...

This command expands/reduces the amplitude so that the peak values within the selected region
of the waveform will be the specified ratio of the upper limit.

7.20. Silence

This command converts the selected region of the waveform to silence.



8. View menu

8.1. Goto

Specifies the portion of the sound data that will be displayed in the waveform display.

Top: Display the beginning of the sound data.

End: Display the end of the sound data.

Sdection Start: Display from the beginning of the selected region.
Selection Erd: Display the end of the selected region at the right edge.
Loop Start: Display from the beginning of the loop region.

Loop End: Display the end of the loop region at the right edge.

Play Location: Display from the beginning of the playback start location.

8.2. Zoom

Modifies the resolution of the waveform display.

Vertical Full Zoom In: Maximize the vertical display resolution.

Vertical Full Zoom Out: Minimize the vertical display resolution.

Horizontal Full Zoom In: Maximize the horizontal display resolution.

Horizontal Full Zoom Out:  Minimize the horizontal display resolution.

Fit Selection: Change the resolution so that the selected region fits
within the waveform display.

Fit Loop: Change the resolution so that the loop region fits within

the waveform display.

8.3. Selection
Select Loop Select the currently specified loop region as the selected
region (highlighted).
Selection to Laop: Specify the currently selected region (highlighted) as the
loop region.

8.4. Auto Zero Cross

When you newly set the start/end points of the selected region or the loop region, or modify the
playback start location, this function will automatically move that point or location to a zero cross
point (a location where the amplitude intersects the center line of the waveform display) if the
specified point or location is near a zero cross point.



8.5. Auto Snap
When you modify either the start point or end point of the selected region or the loop region in the
waveform display, this function will automatically adjust the modified point to a location which

has the same amplitude as the other point (end or start), if such a location of identical amplitude
exists nearby.

8.6. Hide (or Show) Waveform
This toggles the waveform in the waveform display between visible and hidden.

* This does not delete waveform data.

8.7. Overview
This specifies whether or not the overall waveform display will be shown, or selects its location.

Hide (or Show): Toggles the overall waveform display between visible and hidden.

Top: The overall waveform display will appear at the top of the Wave
Window.
Bottom: The overall waveform display will appear at the bottom of the Wave
Window.
8.8. Time Ruler

This selects the units of the time axis (horizontal axis) located above the waveform display.
Time: The time axis will be in units of hours:minutes:seconds.milliseconds.
Sample: The time axis will be in units of samples.
8.9. Level Ruler

This selects the units of the amplitude axis (vertical axis) located at the left of the waveform
display, or specifies whether or not it will be shown.

Hide (or Show): This toggles the amplitude axis between visible and hidden.
%: The amplitude axis will be in percentage units.
dB: The amplitude axis will be in decibel units.

8.10. Scroll During Playback

This specifies whether or not the waveform display will scroll during playback of sound data. If
you want the waveform display to scroll, select and check [Scroll During Playback].

* |f the display resolution (Zoom) of the time axis (horizontal) is 11 or higher, the waveform in the display will be
shown in dark blue, and the waveform display will not scroll even if Scroll During Playback mode is selected.



9. Option menu

9.1. SCSI Rescan
This command causes TWE to re-detect the devices connected to the SCSI bus.
9.2. Windows Sound Device Configuration...

Here you can make input/output settings for the sound card installed in your personal computer. In
the Input and Output boxes, respectively select the devices which will be used for audio input and
output.

9.3. CBX-Dn Configuration...

Make input/output settings for the CBX-D5/D3.

* For details on HD Play/Rec and RAM Play/Rec, refer to "5. About the play modes."
9.4. Select Working Dir...

TWE temporarily creates working files in a directory, and you can use this command to change
the directory.

* The drive name of the newly specified directory will be shown in the "Working Volume:" field of the device
information display (Device) located at the left of the waveform display.

* When specifying the directory in which working files will be created, please select a hard disk which contains
sufficient free area and has a fast access time. (For example, in order to craade anuud file when the entire
waveform has been edited, the sound file will occupy the same amouatefaspthe originabsind file, meaning

that you would need at least twice the size of the original sound file.)

* Be aware that a removable disk cannot be selected.

* |f any temporary working files remain after exiting TWE, use the Explorer to delete them.
9.5. File Backup

Select whether you will be directly editing the original sound file (Original mode), or editing a
copy of the original file (Backup mode).

If [File Backup] is checked, Backup mode (copy editing mode) will be selected. If it is unchecked,
Original mode will be selected. The default setting is Original mode.

* |t is not possible to change the mode for an already-opened sound file. After checking or unchecking [File
Backup] to select one of the two modes, sound files opened by the [File] menu command [Open] will be the
selected mode.

* The editing mode (either Original or Copy) of the sound file currently being edited in TWE is shown in the
"Editing:" field of the file information display (File Info).



9.6. CBX-Dn Recording Monitor

Switch input monitoring on/off.
If this is ON, the input to the CBX-D5/D3 will always be output from the CBX-D5/D3. If this is
OFF, it will be output only during recording.

9.7. Windows Sound System

Specify the sound card installed in the computer as the recording/playback (input/output)
hardware.

9.8. CBX-Dn Processor

Specify the CBX-D5/D3 as the recording/playback (input/output) hardware.

9.9. Preference
A dialog box will open, allowing you to make shortcut key settings. The procedure is as follows.

First, use the Menu and Action (commands provided in each menu) list to select the command for
which you wish to specify a shortcut key. Current Shortcut displays the current shortcut key
setting.

* If you wish to change the shortcut key for a command to which a key has already been assigned, you can also
select the desired command by using the keyboard of your computer to type the currently specified shortcut key.

To cancel an existing shortcut key setting, click the [Clear] button.

To modify the setting, use your computer keyboard to type the desired new key into the New
Shortcut box, and click the [Assign] button. You can also press keys while holding down [Al],
[Ctrl] or [Shift].

* While you are setting the New Shortcut, the [Enter] key will not function as [OK]. Be aware that doing so will
cause the [Enter] key to be selected as the shortcut key for the currently chosen command.

If the shortcut key that is newly input to the New Shortcut box is already used for another
command, the name of that command will appear in the Used Action field. If you now click the
[Assign] button, the shortcut key setting that is assigned to the Used Action will be canceled, and
the shortcut key will be newly assigned to the command that is selected in the Action field.

If you click the [Revert Panel] button, the changes that were made since you opened this dialog
box will be canceled.
If you click the [Initial Setting] button, all shortcut key settings will return to their default values.



10. Window menu

10.1. Toolbar
Here you can select whether each toolbar will be displayed or hidden.
A sub-menu will appear, and you can check the names of the tool bar that you wish to have
displayed.
Console: Toolbar for recording/playing back sound data

Standard: Toolbar with frequently used editing commands
View: Toolbar with settings related to waveform display

10.2. Cascade

All the Wave Windows will be arranged in stairstep fashion.

10.3. Tile Horizontally

All the Wave Windows will be arranged horizontally.

10.4. Tile Vertically

All the Wave Windows will be arranged vertically.

10.5. Arrange Icons

Arrange all the Wave Windows that are minimized.

10.6. Minimize All

All the Wave Windows will be minimized.

10.7. Maximize All

All the Wave Windows will be maximized.

10.8. Close All

All the Wave Windows will be closed.



11. Help menu

11.1. About TWE

This displays the software version of TWE.

12. List of shortcut key default settings

By using shortcut keys, you can use the keys of your computer keyboard to rapidly execute the commands
of the menus or the toolbar. A list of the default settings of the shortcut keys is given below.
(Shortcut key settings can be changed by the [Option] menu command [Preference].)

Menu Command Key Function
File New Ctrl + N Create a new file (blank sound file).
Open Ctrl + O Open an existing sound file.
Close Ctrl + F4 Close the sound file.
Save Ctrl+S In Backup mode, save the edited sound data by
overwriting it onto the original sound file.
Revert Ctrl + R In Backup mode, revert the edited content to the last
saved state.
Quit Alt + F4  Close the currently open sound files, and exit TWE.
Edit Undo(Redo) Ctrl+Z Cancel (or Redo) the result of the previous editing
operation.
Cut Ctrl + X  Cut the selected region, and copy it to the TWE
clipboard.
Copy Ctrl+ C  Copy the selected region to the TWE clipboard.
Paste Ctrl + V  Paste the waveform that was copied to the TWE

clipboard, beginning at the location specified in the
waveform display.

Insert Ctrl + 1 Insert the waveform that was copied to the TWE
clipboard into the location specified in the
waveform display.

Clear Ctrl + Del Delete the selected region.

Select All Ctrl + A Simultaneously select the entire length of the
channel(s) selected in the waveform display, from
the beginning to the end of the sound file.

Trim Ctrl+ T  Delete the first and last portions of the waveform,
leaving only the selected region.
Mix Ctrl+ M Mix the waveform that was copied to the TWE

clipboard into the specified location of the
waveform display.



View

Console

Zoom

Top

End

Selection Start
Selection End

Loop Start
Loop End

Vertical Full Zoom In
Vertical Full Zoom Out
Horizontal Full Zoom In
Horizontal Full Zoom Out
Fit Selection

Fit Loop

Rewind

Stop

Play

Record
Region Play
Loop Mode

Horizontal Zoom In
Horizontal Zoom Out
Vertical Zoom In
Vertical Zoom Out

[<-] Display the beginning of the sound data.

[->] Display the end of the sound data.
Ctrl +[<-] Display from the beginning of the selected region.
Ctrl +[->] Display the end of the selected region at the right

edge.
Alt + Ctrl +[<-] Display from the beginning of the loop
region.
Alt + Ctrl +[->] Display the end of the loop region at the right
edge.
Ctrl+Y Maximize the vertical display resolution.
Ctrl+J  Minimize the vertical display resolution.
Ctrl+ H Maximize the horizontal display resolution.
Ctrl+ G Minimize the horizontal display resolution.
Ctrl+ F  Modify the display resolution so that the selected
region fits in the waveform display area.
Ctrl+ L Modify the display resolution so that the loop

region fits in the waveform display area.

1 (keypad) Move the playback start location to the beginning
of the sound data.
0 (keypad) Stop playback/recording.
Enter Begin playback from the playback start location.
* (keypad) Begin recording from the playback start location.
Space Play back only the selected region.
/(keypad) Switch loop playback on/off.

H Increase the horizontal display resolution by one.
G Decrease the horizontal display resolution by one.
Shift + H Increase the vertical display resolution by one.

Shift + G Decrease the vertical display resolution by one.



13. What's new?

Major new function in version 2.1.5

*FAT32 format hard disk can be selected as the working directory.

Major new functions in version 2.1.0

*The EX7, EX5, and EX5R synthesizers are supported.

*In the [Edit] menu command [Loop cross fade... ], the fade in/out curve can be selected.

*The [View] menu item [Auto Zero Cross] allows a zero cross point to be selected automatically when
you specify the playback start location / selected region / loop region.

*The [View] menu item [Auto Snap] allows the amplitude at the start and end points to be matched
automatically when you specify a selected region or a loop region.

*The [Option] menu item [Preference] allows you to add/modify shortcut keys.

—End-
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